MICROAPP MANAGER Help Index

The index lists the Help topics available for the MicroApp Manager. Use the scroll bar to see entries not
currently visible in the Help window.

To learn how to use help, press F1 or choose Using Help from the Help menu.
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Using MicroApp Manager with a Keyboard

Use the following keyboard commands with MicroApp Manager. For more information about the
Windows keyboard, see Windows Help.

Menu Keys
ALT+letter

Letter

DIR KEYS
ENTER
ESC

Dialog Box Keys
TAB

SHIFT+TAB
ALT+letter

DIR KEY

ALT+DOWN
SPACEBAR

SHIFT+DIR KEY
ENTER

ESC

Help Keys

F1

Window Keys

ALT+SPACEBAR
ALT+F4
ALT+ESC

Chooses the item on the menu bar that has the corresponding underlined letter.
For example, in Windows Express ALT+F chooses the File menu.

Chooses the command on the drop down menu that has the corresponding
underlined letter. For example, in Windows Express, O chooses the Open
command from the File menu.

Moves between menu items.

Chooses the selected menu item.

Cancels the selected menu. The drop down menu disappears.

Moves to the right or down one option at a time.

Moves to the left or up one option at a time.

Moves to the option which corresponds to the underlined letter in its name. For
example, in the Run dialog box, ALT+M chooses the Run Minimized option.
Moves between selections within a group of options or moves up and down
through the items in a list box or text box.

Opens a drop-down list box

Selects an item in a list box, checks or unchecks a checkbox, or chooses the
current selection in a group of options.

Extends the selection in a list box.

Executes all the currently selected options and list items in the dialog box.
Closes the dialog box without completing the command.

Displays the Help window, with the Help index for the application. If you have
chosen a command or you are in a dialog box, the Help text for the command or
dialog box will be displayed instead. If the Help window is already open, F1
takes you back to the Index.

Opens the Control menu for the active window.
Closes the active window.
Switches to the next application window or icon.



Using MICROAPP MANAGER Commands

The MicroApp Manager lets you customize how you work with MicroApps. Use it to arrange individual
MicroApps on the MicroApp Manager menu and decide how and when to launch the MicroApps.

Use the MicroApp Manager commands to organize and manage the individual MicroApps you use.



Run Command

When you choose the Run command, the Run dialog box is displayed so that you can choose the
MicroApps that you want to run as application windows.

Related Topics:
Run Dialog BoxParameters Dialog Box



Run Dialog Box

The Run dialog box displays a list of the available MicroApps. Choose the MicroApp you want to run as
a window, and choose OK to run it. You may choose more than one MicroApp to run.

Related Topics:
Run Command

Running a MicroApp



Parameters Dialog Box

The parameters dialog box allows you to enter a command line to be passed to the MicroApp which is
about to be run. To pass an empty command line, press OK without typing anything in the command line
edit box.



Load Command

When you choose the Load command, the Load dialog box is displayed so that you can choose the
MicroApp you want to run as an icon.

Related Topics:
Load Dialog Box



Load Dialog Box

The Load dialog box displays a list of the available MicroApps. Choose the MicroApp you want to load
as an icon, and choose OK to load it. You may choose more than one MicroApp to load.

Related Topics:
Load Command

Loading a MicroApp



Options Command
When you choose the Options command, the MicroApp Manager Options dialog box appears.

Related Topics:
Options Dialog Box



Options Dialog Box
Use the Options dialog box to choose how you want to display the MicroApp Manager menu.

Tear Off. Choose the "tear off" option to have the MicroApp Manager menu appear as a tear off
menu that you can position on the screen where you want.

All Applications. Choose the All Applications option to have the MicroApp Manager menu
appear on every individual application.

MicroApp Path. Type the pathname for the location of the MicroApps in the path text box. You
may type more than one pathname separated by semicolons.

Prompt for MicroApp Parameters. Use the Prompt For MicroApp Parameters check box to
indicate whether you want to be prompted for MicroApp parameters when you start them.

Choose OK to confirm your choices in the Options dialog box.

Related Topics:
Options Command



Quick Launch Command

The Quick Launch command lets you place MicroApps on the MicroApps Manager menu, so they can be
started easily. When you choose the Quick Launch command, the Quick Launch Dialog Box appears.

Related Topics:
Quick Launch Dialog Box



Quick Launch Dialog Box

The Quick Launch dialog box displays a list box of Available MicroApps on the left side of the box.
Highlight a MicroApp to choose it. Then, use the Add button to add it to the MicroApps on Menu list box
on the right.

Highlight a MicroApp in the MicroApps on Menu list box and press the Remove button to delete it from the
MicroApps Manager menu.

You can also use the Move Up and Move Down buttons to change the position of a MicroApp on the
menu. First, highlight it in the MicroApps on Menu list. Then, use the Move Up or Move Down buttons
to move it up or down.

The Describe button displays a description of the highlighted MicroApp.

When you have made your choices on the Quick Launch menu, choose OK to confirm them, or Cancel to
cancel them.

Related Topics:
Quick Launch Command



Initial Launch Command

The Initial Launch command displays the Initial Launch dialog box so that you can choose which
MicroApps will be launched automatically when you start the MicroApp Manager.

Related Topics:

Initial Launch Dialog Box
Starting a MicroApp Automatically



Initial Launch Dialog Box

The Initial Launch dialog box displays a list box of Available MicroApps on the left side of the box.
Highlight a MicroApp to choose it.

Use the Add button to add it to the the MicroApps to Launch list box on the right.
Highlight a MicroApp in the MicroApps to Launch list box and press the Remove button to delete it.

You can also use the Move Up and Move Down buttons to change the position of a MicroApp on the
menu. First, highlight it in the MicroApps on Menu list. Then, use the Move Up or Move Down buttons
to move it up or down. The Describe button displays a description of the highlighted MicroApp. For
each MicroApp, you can decide to launch it as a window or as an icon, by clicking the As window or As
Icon buttons.

When you have made your choices on the Initial Launch menu, choose OK to confirm them, or Cancel to
cancel them.

Related Topics:
Initial Launch Command

Starting a MicroApp Automatically



Remove MicroApp Manager Command

When you choose this command, the MicroApp Manager is removed, along with any MicroApps that are
currently running. You will see a warning box asking you to confirm that you really want to remove the
MicroApp Manager.



About MicroApp Manager

The About command displays information about MicroApp Manager. Use the Help button to get more
information about how to use.



Using MICROAPP MANAGER Procedures

The MicroApp Manager lets you display each MicroApp in the order you choose on a drop-down menu so
that they can be launched quickly, or you can choose to automatically launch individual MicroApps
whenever you start the MicroApp Manager. The individual MicroApps may be run as either application

windows or icons.



There are three ways to start a MicroApp

1. Choose it from the MicroApp Manager menu.
2. Start it automatically when you start MicroApp Manager.
3. Choose a command from the MicroApp Manager menu.



To add a MicroApp to the MicroApp Manager menu

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Quick Launch..." to display the quick launch dialog box.

3. Click the MicroApp you want to add in the MicroApps Available list box. If you're not
sure what a MicroApp is used for, click the Describe button to display a description of that
MicroApp. To add more than one MicroApp, press and hold SHIFT while you click each
MicroApp you want to add.

4. Click the Add button. The MicroApp is added to the bottom of the MicroApps on
Menu list box.

5. Click the MicroApp you just added in the MicroApps on Menu list box.

6. Click the Move Up and Move Down buttons to position the MicroApp name where you
want it in the list.

7. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press Q to choose "Quick Launch..." and display the quick launch dialog box.

3. Press ALT+A to choose the MicroApps Available list box.

4. Press the DIRECTION keys to select the MicroApp you want to add.

5. Press ALT+D to choose the Add button. The MicroApp is added to the MicroApps on
Menu list box.

6. Press ALT+M to choose the MicroApps on Menu list box. Then, press the
DIRECTION keys to select the MicroApp you just added.

7. Press SPACEBAR to select the MicroApp. Then, press ALT+U or ALT+W to move
the MicroApp to the position you want it in the list.

8. Press ENTER.

Quick Launch Dialog Box



To delete a MicroApp from the MicroApp Manager menu

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Quick Launch..." to display the quick launch dialog box.

3. Click the MicroApp you want to delete in the MicroApps on Menu list box. If you're
not sure what the MicroApp does, click the Describe button. To delete more than one
MicroApp, press and hold SHIFT while you click each MicroApp you want to delete.

4. Click the Remove button. The MicroApp is deleted from the MicroApps on Menu list
box.

5. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR,
and press | to choose "MicroApp Manager: and display the MicroApp Manager menu.

2. Press Q to choose "Quick Launch..." and display the quick launch dialog box.

3. Press ALT+M to choose the MicroApps on Menu list box.

4. Press the DIRECTION keys to select the MicroApp you want to delete. Then, press
SPACEBAR to choose it. If you're not sure what the MicroApp does, click the Describe
button. To delete more than one MicroApp, repeat this step for each MicroApp you want
to delete.

5. Press ALT+V to choose the Remove button. The MicroApp is deleted from the
MicroApps on Menu list box.

6. Press ENTER.

Quick Launch Dialog Box



To move a MicroApp on the menu

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager Menu. Click the MicroApp Manager icon. Then, click
"MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Quick Launch..." to display the quick launch dialog boxTERM_DIALOGBOX.

3. Click the MicroApp you want to move in the MicroApps on Menu list box. Then, click
the Move UP and Move Down buttons to move the MicroApp where you want. If you're
not sure what a MicroApp is used for, click the Describe button to display a description of
that MicroApp.

4. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+ESC to choose
the icon. Then, press ALT+SPACEBAR, and press | to choose "MicroApp Manager" and
display the MicroApp Manager menu.

2. Press Q to choose "Quick Launch..." and display the quick launch dialog box.

3. Press ALT+M to choose the MicroApps on Menu list box.

4. Press the DIRECTION keys to select the MicroApp you want to move. Then, press
ALT+U and ALT+W to use the Move UP and Move Down buttons to move the MicroApp
where you want. If you're not sure what a MicroApp is used for, press ALT+B to display
a description of that MicroApp.

5. Press ENTER.

Quick Launch Dialog Box



To start a MicroApp automatically

Mouse 1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager: to display the MicroApp Manager menu.
2. Click "Initial Launch..." to display the initial launch dialog box.
3. Click the MicroApp you want to start automatically in the MicroApps Available list box.
If you're not sure what a MicroApp is used for, click the Describe button to display a
description of that MicroApp. To select more than one MicroApp, press and hold SHIFT
while you click each MicroApp you want.
4. Click the Add button. The MicroApp is added to the bottom of the MicroApps to
Launch list box. If you want the MicroApp to be started before another MicroApp shown
in the list box, click the MicroApp in the MicroApps to Launch list box. Then, click the
Move Up and Move Down buttons to move it.
5. If you want the MicroApp to be started as an icon, click the MicroApp. Then, click
the As Icon option button.
6. Choose OK.

Keyboard 1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press | to choose "Initial Launch..." and display the initial launch dialog box.

3. Press ALT+A to choose the MicroApps Available list box.

4. Press the DIRECTION keys to select the MicroApp you want to automatically start.
Then, press SPACEBAR to choose it. If you're not sure what a MicroApp is used for,
press ALT+B to display a description of that MicroApp. To add more than one MicroApp,
repeat this step for each MicroApp you want to add.

5. Press ALT+D to choose the Add button. The MicroApp is added to the MicroApps to
Launch list box. If you want the MicroApp to be started before another MicroApp shown
in the list box, press ALT+M to choose the MicroApps to Launch list box. Then, use the
DIRECTION keys to select the MicroApp you want to move. Press ALT+U and ALT+W
to move the MicroApp to the starting position you want.

6. If you want to start the MicroApp as an icon, press ALT+M to choose the MicroApps
to Launch list box. Then, press the DIRECTION keys to select the MicroApp you want,
press SPACEBAR, and press ALT+| to choose the As Icon option button.

Related Topics:
Initial Launch Dialog Box



To stop a MicroApp from starting automatically

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager: to display the MicroApp Manager menu.

2. Click "Initial Launch..." to display the initial launch dialog box.

3. Click the MicroApp you want to stop from starting automatically in the MicroApps
Available list box. If you're not sure what a MicroApp is used for, click the Describe
button to display a description of that MicroApp. To select more than one MicroApp,
press and hold SHIFT while you click each MicroApp you want.

4. Click the Remove button. The MicroApp is remove from the MicroApps to Launch
list box.

5. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press | to choose "Initial Launch..." and display the initial launch dialog box.

3. Press ALT+A to choose the MicroApps Available list box.

4. Press the DIRECTION keys to select the MicroApp you want to stop from starting
automatically. Then, press SPACEBAR to choose it. If you're not sure what a MicroApp
is used for, press ALT+B to display a description of that MicroApp. To add more than
one MicroApp, repeat this step for each MicroApp you want to add.

5. Press ALT+V to choose the Remove button. The MicroApp is removed from the
MicroApps to Launch list box.

5. Choose OK.

Initial Launch Dialog Box



To change the order in which MicroApps start automatically

Mouse

Keyboard

1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Initial Launch..." to display the initial launch dialog box.

3. Click the MicroApp for which you want to change the starting order in the MicroApps
Available list box. If you're not sure what a MicroApp is used for, click the Describe
button to display a description of that MicroApp.

4. Click the Move Up and Move Down buttons to move it where you want.

5. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press | to choose "Initial Launch..." and display the initial launch dialog box.

3. Press ALT+L to choose the MicroApps to Launch list box.

4. Press the DIRECTION keys to select the MicroApp for which you want to change the
starting order.

5. Press ALT+U and ALT+W to move the MicroApp to the starting position you want.

6. Choose OK.



To run a MicroApp

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager menu. Click the MicroApp Manger icon. Then click
"MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Run MicroApp" to display the run dialog box.

3. Click the MlcroAppo you want to run. To run more than one MicroApp, press and
hold SHIFT while you click each MicroApp you want.

4. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press R to choose "Run MicroApp..." and display the run dialog box.

3. Press the DIRECTION keys to select the MicroApp you want to start. Then, press
SPACEBAR to choose it. To start more than one MicroApp, repeat this step for each
MicroApp you want.

4. Press ENTER.

Run Command



To load a MicroApp

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Load MicroApp..." to display the load dialog box.

3. Click the MicroApp you want to load. To load more than one MicroApp, press and
hold SHIFT while you click each MicroApp you want.

4. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp is not displayed in every
window, press ALT+ESC to choose the icon. Then press ALT+SPACEBAR to display the
menu. Otherwise, press ALT+SPACEBAR to display the menu.

2. Press L to choose "Load MicroApp..." and display the load dialog box.

3. Press the DIRECTION keys to select the MicroApp you want to load. Then, press
SPACEBAR to choose it. To load more than one MicroApp, repeat for each MicroApp
you want.

4. Press ENTER.

Load Command



To position the MicroApp Manager icon

Mouse

Keyboard

Related Topics:

1. Display the MicroApp Manager icon. Click the MicroApp Manager icon. Then, click
"MicroApp Manager" to display the MicroApp Manager menu.

2. Click "Options..." to display the options dialog box.

3. Click All Applications to display the icon in every window, or click Tear Off to display it
in the icon area.

4. Choose OK.

1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Other wise, press ALT+SPACEBAR to display the menu.

2. Press O to choose "Options..." and display the options dialog box.

3. Press Ato choose All Applications to display the icon in every window or press T to
choose Tear Off and display the icon in the icon area.

4. Press ENTER.

Options Dialog Box



To prompt for MicroApp parameters

Mouse 1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager" to display the MicroApp Manager menu.
2. Click "Options..." to display the options dialog box.
3. Click the Prompt for MicroApp Parameters checkbox to select it.
4. Choose OK.

Keyboard 1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu. Otherwise, press ATL+SPACEBAR to display the menu.

2. Press O to choose "Options..." and display the options dialog box.
3. Press R to choose the checkbox Prompt for MicroApp Parameters.
4. Press ENTER.

Related Topics:
Options Dialog Box



To specify a new MicroApp path

Mouse 1. Display the MicroApp Manager menu. Click the MicroApp Manager icon. Then,
click "MicroApp Manager: to display the MicroApp Manager menu.
2. Click "Options..." to display the options dialog box.
3. Click the MicroApp Path text box, and type the new pathname.
4. Choose OK.

Keyboard 1. Display the MicroApp Manager menu. If the MicroApp Manager icon is not displayed
in every window, press ALT+ESC to choose the icon. Then, press ALT+SPACEBAR to
display the menu.

2. Press O to choose "Options..." and display the options dialog box.
3. Press P to choose MicroApp Path. Then, type the new pathname in the text box.
4. Press ENTER.

Related Topics:
Options Dialog Box



To customize the hDC interface

You can customize the appearance of the hDC interface by modifying the [hDC Library] section of the
HDC.INI file. Your changes take effect the next time you start MicroApps.

The hDC interface includes: three-dimensional buttons in dialog boxes; windows that "zoom" as they
open and close; and dropshadows that enhance the three-dimensional quality of your windows.

Note: If you prefer using the standard Windows interface with your MicroApps, you can disable the hDC
interface. To do this, add or change the following line in the [hnDC Library] section of the HDC.INI file:
Enhanced Mode=0

Zooming windows

The hDC interface includes a feature that "zooms" a window when it is minimized or restored. To
cancel the zooming effect, add (or edit) the following line in the [hDC Library] section of the HDC.INI
file:

Zoom=0

Shadowing windows

The hDC interface also adds a dropshadow to the borders of windows and dialog boxes. To omit or
edit the appearance of the dropshadows, modify the following lines in the [nDC Library] section of the
HDC.INI file:

Shadow X=[number of pixels]

Shadow Y=[number of pixels]

Shadow Color=[Red value, Green value, Blue value]

Shadow X is the horizontal shadow displayed on the bottom of a window, and Shadow Y is the vertical
shadow displayed on the right side of the window. To turn off either shadow, change its value to 0
pixels. To increase the width of the shadow, increase the number of pixels.

If you have a color monitor, you can change the color of the shadow. To do this, change the Red,
Green and Blue values in Shadow Color by specifying a value between 0 and 255 for each color.
Increase each value to add more of that color to the shadow. For more information about specifying
color values, see the [colors] section of your SYSTEM.INI file.



To close a MicroApp

Mouse 1. Display the MicroApp menu. Click the MicroApp icon or click its Control menu.
Click "Close."
Keyboard 1. Press ALT+ESC to choose the MicroApp window or icon
2. Press ALT+F4 to close the MicroApp.



To close all MicroApps and the MicroApp Manager

Mouse 1. Click the MicroApp Manager icon.
2. Click "Close." You will be asked to confirm that you want to close the MicroApp
Manager.

Keyboard 1. Press ALT+ESC to choose the MicroApp Manager icon.
2. Press ALT+F4. You will be asked to confirm that you want to close the MicroApp
Manager.



active

The window that will be affected by the next keystroke or command. If a window is active, its title bar
changes color so that you can see it easily.



application

A program that accomplishes a specific task, such as a word processor or spreadsheet.



batch file

A text file with the extension .BAT that contains DOS commands.



cascade

A way to arrange open windows on the desktop so that they are overlapping (See also "Tile.").



checkbox

A square in a dialog box that you can choose to select an option. If the option is chosen, an X will
appear in the checkbox.



click

To press and release the mouse button to execute an action.



clipboard

A special Windows facility for transferring information from one application to another. When you cut or
copy information from an application it goes into the clipboard. When you paste information, it is copied
from the clipboard to the active window.



Control menu

The menu on most windows and some dialog boxes that appear in the upper left corner of every window,
represented by a small horizontal bar. The Control menu lets you move, resize, and close the window or
dialog box.



desktop pattern

A geometric pattern that appears on the desktop.



dialog box

A special window that appears on the screen when you are using a command. The dialog box lets you
make choices and select options for the command you are using.



direction keys

The four arrow keys on the keyboard, used to move up, down, left, and right.



directory

A collection of files and/or subdirectories.



document

A file created with an application.



DOS search path

A list of the directories where DOS and Windows will look for an application if it is not located in the
current directory. The path can be set with the DOS PATH command, which can be placed in the

AUTOEXEC.BAT file.



double click

To quickly press and release the mouse button twice in succession to execute an action.



drag

To move the mouse pointer while you are holding down the mouse button.



drop-down menu

A list of command choices which can be displayed when you drag the mouse down from the menu bar or
press the ALT key along with the underlined letter on a menu choice.



executable file

A DOS or Windows program file with the filename extension .EXE.



filename

The name of a document. A filename can have up to eight alphanumeric characters, plus an extension.
An extension begins with a period and can have up to three characters. Normally, the extension
indicates the type of file. For example, files with the extension .BAT are batch files.



keyword

An underlined word or phrase appearing in a Help description  Press and hold down SHIFT and ENTER
to display its definition.



list box

A box within a dialog box from which you choose an item. such as file or directory names. Use mouse
or DIRECTION keys to highlight items. If there are more items than can fit in the box at once, you can
use the scroll bar to see the rest of the list.



maximize

To enlarge the application in the active window or icon to fill the screen.



menu bar

The horizontal bar at the top of a window, which contains the names of the application's menus. Use the
mouse or ALT+the underlined letter key to drop down command menus.



minimize

To shrink the active window to an icon



non-Windows application

An application that does not require Microsoft Windows in order to run.



option button

A small circle in a dialog box that can be selected to choose an option. The option is selected if the
option button is filled in. To choose an option, click the button with the mouse or use the TAB key to
move to the option and use the SPACEBAR to select it.



overlap

A way to arrange windows on the desktop, so that they partially cover one and other (See also
"Cascade.")



pathname

The name and location of a file, including the filename, directory, and drive locations. A full pathname
includes a drive letter followed by a colon, one or more directory names separated by a backslash (\), and
a filename.



PIF (Program Information File)

A program information file. This is a special file created for non-Windows applications so that they can
be run from Windows.



restore

To use the Restore button or command to return a window or icon to its previous size.



scroll

To move the contents of a window or dialog box up, down, left, or right.



scroll bar

A bar which appears at the right side or bottom of the current window when the contents are not
completely visible. You can use the scroll bar to move the contents of the window.



text box

A box within a dialog box where you type text, such as a filename.



tile

A way to arrange open windows on the desktop, so that they do not overlap.



Windows application

An application that requires Microsoft Windows in order to run and which takes advantage of the Windows
graphical user interface.






